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Opplegg for sesjonen

• Presentasjon fra DNV/UiS på ca 20 min

• Inndeling i grupper – ca 7-8 personer?

• Gruppene får et sett med diskusjonstemaer og velger selv hvilke de vil fokusere på

• Hvis det er viktige forhold som vi ikke tar opp i våre diskusjonstemaer, kan dere også 
adressere disse

• Gruppearbeid:
• Oppnevnes en person som styrer diskusjonen i gruppen
• En person skriver ned input fra gruppen på PC og sender til ragnar.tveteras@uis.no.
• Spissformuler hovedtemaer som opptok gruppen, og evt. anbefalinger
• Gruppen presenterer (noe av) sin input muntlig, maks 2 minutter

• Vi vil arrangere et Teams møte i ettertid hvor vi bruker deres input fra stormøtet, og drøfter 
videre sammen
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Bakgrunnsmateriale

• Notat fra DNV basert på

• Lover, forskrifter, koder og standarder

• Vurdering av relevante regelverk fra andre industrier

• Basis – tidligere regelrammeverk fra DNV

• Intervjuer med aktører fra offentlig sektor, designere, oppdrettere
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Reguleringsgrunnlag for oppdrett

• Akvakulturloven
• Forurensingsloven
• Havne- og farvannsloven
• Arbeidsmiljøloven
• Brann og eksplosjonsloven
• El-tilsynsloven

• Forskrift om krav til teknisk standard for flytende akvakulturanlegg (NYTEK-forskriften)
• Forskrift om systematisk helse-, miljø- og sikkerhetsarbeid i virksomheter (Internkontrollforskriften)
• Forskrift om internkontroll for å oppfylle akvakulturlovgivningen (IK-Akvakultur)
• Forskrift om håndtering av brannfarlig, reaksjonsfarlig og trykksatt stoff 
• Arbeidsplassforskriften
• Akvakulturdriftsforskriften
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Acts

Regulations

Guidelines

Norms and standards
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Hva er ikke dekket i Nytek/NS 9415
• NYTEK23: “Forskriften skal bidra til å forebygge rømming av fisk fra akvakulturanlegg i sjø, 

innsjø og vassdrag gjennom å sikre forsvarlig teknisk standard på anleggene.”

• NS 9415:2021: “Tekniske krav eller driftsoppgaver som ikke har relevans for rømming av 
oppdrettsfisk, omfattes ikke av denne standarden.”

• Arbeidsmiljø til sjøs: Arbeidstilsynet (landbasert)
• Jobb på akvakulturanlegg er den nest farligste arbeidsplassen i Norge (SINTEF Ocean, 2016)

• Brannsikring – Kommunikasjon – Navigasjon - Livreddende utstyr – Marine systemer: Ikke/dårlig dekket 
av NS 9415

• Fokusert på hovedkomponenter:
• Innhegning
• Flyter
• Flåte
• Fortøyning
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Mer tilpasset annet enn tradisjonelle mærder enn 9415:2009

Hovedsakelig referert til NS-EN…..

DNV-OS-E301 for utmatting av forankring
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Utfordringer med nye konstruksjoner
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• Sammenlignet med vanlig fiskefarm
• Blanding av ulike lovgivninger
• Uklare regler / nye koder
• Helt nye konstruksjoner – innovasjon
• Ny teknologi
• Endret risikobilde
• Endrede miljølaster
• Bemanning?
• Posisjon
• Pantsetting/realregister

Ocean FarmingNSK/Nordlaks

NRS/Aker
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Hovedtyper reguleringer
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• Funksjonsbasert
• Fleksibelt
• Krever høyt kompetansenivå
• Bruk av risikoanalyser for å oppnå riktig sikkerhetsnivå
• Krever tillit mellom partene siden det åpner for skjønnsmessige beslutninger

• Preskriptive
• Normalt klart definert
• Lette å forstå og følge opp
• Lite fleksibilitet for innovasjoner
• Kan føre til minimumsløsninger
• Kan føre til dårlig oversikt over prosjektets totale risiko
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Eksempler på relevante regelverk

• Hva er relevant?
• Tilknytting til sjø
• Norske farevann
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Relevante regelverk/lovverk – struktur/stabilitet
• Naturlig å bruke dem som er vanlige i Norge

• Nytek
• Norsok
• DNV Offshore klasse
• DNV Skipsregler

• Beregningsmetodikk
• Relevant direkte beregning av laster

• Basis for utvelgelse
• Bevegelse?
• Inspeksjonsmuligheter
• Reparasjonsmuligheter
• Konsekvens

• Regelverk - Hva ligner mest
• Offshore regelverk
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Eksisterende reguleringer fra andre industrier
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• Petroleumsindustrien
• Innretningsforskriften, rammeforskriften, styringsforskriften og 

aktivitetsforskriften gir sammen med retningslinjer som peker på 
relevante standarder en full oversikt over krav til installasjonen

• Relevante standarder og retningslinjer fra en rekke anerkjente 
selskap

• Mobil offshoreenhet
• Godkjent klassenotasjon og NMA krav (rødboka), eller
• Godkjent klassenotasjon og flaggstatkrav med samme 

sikkerhetsnivå
• Må ha AoC (Acknowledgement of compliance) 

• Maritim industri
• Godkjennes med en klassenotasjon og krav fra relevant flaggstat
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Hva er et “Regelrammeverk”
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En samling av relevante regelverk for konstruksjonen innen et eller flere områder.

Kan inkludere Nytek/NS 9415 for å ha et komplett rammeverk.

Vedlegg til Design Basis/Brief.
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Hovedtemaer for intervjuer

• Kunnskapsstatus

• Kunnskapsbygging

• Forvaltning og regelverk

• Innovasjon
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Innspill fra intervju

• Regulations
• General thoughts related to basic building blocks for new 

regulations for HTH. How should this be built up, what should 
it include, how to include different risks, etc.

• Specific comments on existing regulations and their fit for the 
new industry.

• HSE
• General comments around important issues for HSE.
• Specific comments on existing regulations and their fit for the 

new industry.

• Competence
• General thoughts about important issues related to the 

competence onboard the installation.
• Innovation needs for the industry when moving offshore.
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• Risk/safety
• Comments about today’s safety management and needs for 

the future

• Regulatory bodies
• Comments about the relevance and suitability of the different 

regulatory bodies for HTH. 

• Accreditation/verification/Class
• Comments related to relevance of the different assurance 

parties and challenges related to assurance of design. 

• Owners and designers
• Important issues for owners and designers when going 

offshore.
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Innspill fra intervju

• Generelle kommentarer

• Funksjonsbasert regelverk bør benyttes
• Dekker innovasjoner
• God oversikt over akseptable kombinasjoner for 

eksisterende regulering/standard

• Må ta hensyn til biologiske utfordringer

• Må se det store bildet - sammenhenger
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Reguleringer
• Spesifikke

• Bruk maritim tilnærming
• Internasjonal
• O&G er overkill
• Standard løsninger

• Må bruke læring fra O&G
• Ligner O&G løsninger
• Funksjonsbasert og åpen for innovasjon
• Må ta hensyn til endret risikobilde

• NYTEK er ikke tilstrekkelig
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Innspill fra intervju

• Generelt

• Må ta hensyn lange distanser fra land

• Funksjonsbasert med barrierestyring
• Akseptkriterier på forhånd - ikke beslutninger på mærdkanten
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HSE
• Spesifikke

• Arbeidsmiljøloven bør være basis
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Innspill fra intervju

• Generelt

• Det bør være kompetansekrav til mannskap
• Maritim kompetanse
• Mulighet til å vedlikeholde sertifikat
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Kompetanse
• Innovasjon

• Utstyr fra dagens oppdrett er ikke nødvendigvis 
tilstrekkelig for HTH
• Må oppgradere kunnskap om nett
• Bruk av teknologikvalifisering for å kvalifisere teknologi
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Innspill fra intervju

• Dagens risikostyring er ikke god nok
• Tror de har bedre kontroll enn de har
• Må se på sikkerhet i et helhetsperspektiv
• Må bedre beredskap og sikkerhetsstyring

• Fare for at konsepter er bygd uten tilstrekkelig 
sikkerhetsnivå
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Risiko - sikkerhetsnivå
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Innspill fra intervju

• Det bør være et koordinerende organ
• Fiskeridirektoratet bør koordinere
• Sjøfartsdirektoratet bør koordinere
• Må være god koordinering mellom etater og klare 

ansvarsforhold
• Ansvarsforhold i henhold til eksisterende kompetanse
• Etater må samarbeide
• Oppfølging i operasjon må være klart definert

• Samarbeide mellom etater må bedres
• Ser ut til at det er en posisjoneringskamp nå
• Viktigere at ansvarsforhold er klart definert enn hvem som har

det
• Må holde seg til sine kompetanseområder
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Kontrollorgan
• PTIL

• Skeptisk til å gi dem stor rolle, de må tilpasse/endre seg 
masse for å tilpasse seg til oppdrett

• PTIL er best i klassen når det gjelder veiledning etter 
standarder

• De fleste konsepter ser ikke ut som skip => mest relevant å 
bruke PTIL og arbeidsmiljøloven

• Arbeidsmiljø
• Arbeidstilsynet har ikke riktig kompetanse
• Det er vanskelig å forholde seg til arbeidstilsynet
• Arbeidstilsynet forstår ikke utfordringene i HTH
• Sjøfartsdirektoratet bør ha ansvar for HSE
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Innspill fra intervju

• Akkreditering/verifikasjon
• Må sørge for at aktører er kvalifisert
• Akkreditering bør ikke brukes for HTH – se til O&G
• Noen akkrediterings selskap og klasseselskap har ikke 

tilstrekkelig kompetanse eller holdning
• Noen gjør begrenset arbeid til lav pris
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Akkreditering/verifikasjon

• Eiere/designere
• Bør være krav til eiere/operatører av HTH
• Mage eiere har dårlig styring og kommunikasjon. Dette er

ikke akseptabelt for HTH
• Det bør være en kvalifisering av organisasjoner som skal 

operere innen HTH
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Gruppearbeid

• Ta tak i et eller flere tema dere ønsker å fokusere på
• Hva er viktig innenfor dette temaet
• Sørg for å få fram det dere mener
• Spissformuler gjerne rundt tema og anbefalinger
• Gruppen presenterer (noe av) sin input muntlig, maks 2 minutter
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Gruppearbeid

• Hva er det som er spesielt viktig for HTH i framtiden

• Hvordan skal HTH bli en suksess

• Hva må man unngå/hvilke farer må man få kontroll på – viktige risikofaktorer

• Viktige innovasjoner for å ha teknisk kontroll over installasjonen

• Hva er viktig for å få riktig utvikling framover

• Viktige poeng til myndigheter

• Er det noe som ikke er adressert i rapporten/presentasjonen

• Ta utgangspunkt i temaene presentert eller er det noe annet som bør prioriteres
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www.dnv.com
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TIPS & TRICKS - YOUR USER GUIDE

TEXT STYLES
Use the TAB-key to jump through 
levels. Click ENTER, then TAB to switch 
from one level to the next level

To go back in levels use SHIFT-TAB

Alternatively, Increase and
Decrease list level can be used

Reset slide

Click the Reset menu to reset position, size 
and formatting of the slide placeholders to 
their default settings

SLIDES & LAYOUTS
Click on the menu New Slide in the Home
tab to insert a new slide

Change layout

Click on the arrow next to Layout
to view a dropdown menu of possible slide 
layouts

PICTURES
On slides with pictureplaceholder, click on 
the icon and choose Insert

Crop picture

1. Click Crop to change size or 
focus of the picture

2. If you want to scale the picture, 
hold SHIFT-key down while 
dragging the corners of the picture

HINT: If you delete the picture and 
insert a new one, the picture may 
lie in front of the text or graphic.
If this happens, select the picture, 
right-click and choose Send to Back

HEADER & FOOTER
Do this at the very end to apply the changes 
on all slides

Click on Header and Footer in the Insert tab 
(write the desired text, click date or page 
number from or to)

Click Apply to All or Apply if only used on 
one slide

GRIDLINES
Click the View tab and set tick mark next to 
Guides

HINT: Alt + F9 for quick view of guides

COPY/PASTE 
CONTENT
When copying old content to your new 
presentation, 2 options are available:

1. Best practice: Create a slide in your new 
presentation and copy one piece of content 
at a time (e.g. copy all text from one textbox)

2. Or copy an entire slide into your new 
presentation and then choose a fitting layout. 
Remember to delete the old, wrong layouts 
(go to View > Slidemaster and delete them)
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